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Введение 
С целью сокращения цикла разработки, повышения качества и надежности, 

с целью снижения материалоемкости конструкций работы по проектированию 

изделий аэрокосмической промышленности в настоящее время ведутся с 

применением средств инженерного анализа и оптимизации, реализующих метод 

конечных элементов [1,2]. Разработанная конечно-элементная модель (КЭ-

модель) проектируемой конструкции. позволяет исследовать, анализировать и 

оптимизировать конструкцию целиком и каждый ее элемент в компьютерной, 

виртуальной среде до изготовления дорогостоящей конструкции. При этом 

проектирование сложных современных конструкций, как правило, требует 

совместного использования широкого набора различных программных систем 

инженерного анализа, ответственных за тот или иной этап расчетного 

сопровождения проекта. 

Основными инструментами компьютерного моделирования конструкций на 

сегодняшний день являются: 

1. Программные системы геометрического моделирования и автоматизации

конструкторских работ CAD (Computer-Aided Design). Наиболее популярные в

мире системы геометрического моделирования - AutoCAD, CATIA,

Pro/ENGINEER, SolidWorks и другие.

2. Программные системы CAE (Computer-Aided Engineering) – системы инженерного

моделирования, анализа и оптимизации конструкций. Это системы, реализующие

метод конечных элементов. Наиболее популярные в мире системы CAE -

программные продукты MSC.Software Corporation - Nastran, Marc, Adams, Dytran,

FlightLoads and Dynamics, а также программные продукты других разработчиков,

например, ANSIS.

Инженер, не имеющий практических навыков работы в этих системах и не 

понимающий основных идей лежащих в основе конечно-элементного 

проектирования на основе конечно-элементного моделирования не способен 

выполнять работы по разработке силовой работы конструкций на современном 

уровне. 

Для подготовки к такому аспекту их будущей работы служит этот 

лабораторный практикум. Изучение практической работы с CAE системами 



проводится в среде конечно- элементной системы MSC.Nastran и пре-

процессора Patran. Практикум знакомит пользователя с основными идеями 

технологии конечно-элементного проектирования конструкций и разработки 

конечно-элементных моделей, помогает начать работать в сложной 

интеллектуальной среде программного продукта MSC.Nastran и пре- и 

постпроцессора MSC.Patran на примерах моделирования, расчетов и 

оптимизации конструкций разного типа, характерных для ракетно-

космической техники. 

При подготовке практикума использованы материалы фирменного 

руководства на английском языке [3, 4], которые могут быть полезными для 

дальнейшего углубленного самостоятельного совершенствования в данной 

области. 



1 Основные шаги компьютерного виртуального 
проектирования конструкций на основе КЭ-
моделей 

Применение конечно-элементных технологий при проектировании 

конструкций начинается с ранних этапов проектирования, когда внесение 

изменений в проект связано с наименьшими трудностями и продолжается на 

всех этапах проектирования вплоть до разработки конструкторской 

документации, поверочных и сертификационных расчетов, подготовки 

испытаний и запуска изделия в производство. 

Проектировщик начинает свою работу с разработки конечно-

элементной модели конструкции, в которую он закладывает необходимые, по 

его мнению, силовые элементы, чтобы конструкция соответствовала своему 

назначению. Приложив силы, которые будут действовать на будущую 

конструкцию, он получит деформации конструкции, силы и напряжения, 

действующие во всех деталях. Анализируя эти данные, он может менять 

конструкционные материалы, силовую схему, размеры и форму деталей, 

чтобы добиться улучшения конструкции, проверяя внесенные изменения 

расчетами. Таким образом, проектировщик дорабатывает и улучшает КЭ-

модель, рассчитывая все воздействия на конструкцию, проверяя все 

требования, предъявляемые к конструкции, и в результате получает КЭ-

модель конструкции, удовлетворяющей этим требованиям. В реальности 

этой конструкции еще нет. Ее нужно разработать так, чтобы она 

соответствовала своей КЭ-модели. Такой порядок проектирования возник и 

развивается в связи с появлением и развитием систем, реализующих метод 

конечных элементов. Он получил название «от модели к конструкции» или 

«Virtual Product Development», что можно перевести как виртуальное 

исследование изделия или виртуальное проектирование (VPD – технология). 

Важной особенностью проектирования на КЭ-моделях является 

возможность увидеть на экране монитора в наглядном виде, в интерактивном 

режиме, во всех ракурсах, в целом и по частям, в реальных пропорциях 

будущую конструкцию, что помогает составить о ней правильное 

представление и мобилизует интуицию для ее совершенствования. 

Возможность вывести на экран (визуализировать) сечения элементов, 



закрепления, нагрузки позволяет эффективно контролировать исходные 

данные. Отображение непосредственно на КЭ-модели в наглядном масштабе 

деформаций нагруженной конструкции, при свободных колебаниях, в 

переходных динамических процессах в виде линий равных уровней, 

графиков; отображение внутренних усилий, напряжений в виде эпюр, линий 

равных уровней, графиков, позволяют оперативно и наглядно получать 

детальную информацию о силовой работе конструкции, выявлять 

недостатки, предлагать изменения. Создается впечатление работы с реальной 

конструкцией, хотя ее еще не существует. Отсюда и происходит термин 

«виртуальное проектирование». 

В настоящее время проектирование конструкций во всех ведущих 

фирмах мира осуществляется с помощью МКЭ. Это обусловлено 

преимуществами МКЭ по сравнению с традиционными методами 

моделирования и расчетов. Среди этих преимуществ можно выделить 

следующие: 

▪ МКЭ предоставляет проектировщику возможность исследовать работу 

конструкции практически любой сложности с учетом всех особенностей данной 

конструкции. Благодаря этому стало возможным создание подробной конечно- 

элементной модели (КЭ-модели) конструкции изделия в целом; и исследовать 

взаимодействие всех ее основных силовых элементов; 

▪ Оперативность получения результатов и их надежность. Корректно 

выполненный конечно-элементный расчет (КЭ-расчет) можно сравнить с 

натурными испытаниями с той лишь разницей, что он проводится не в цехе, а в 

памяти компьютера; 

▪ Оперативность получения результатов позволяет за короткое время 

рассмотреть много вариантов реализации конструкции, что само по себе ценно, 

но, кроме того, позволяет инженеру, анализирующему разные варианты, быстро 

получить большой опыт. Этому также способствует то, что в результате 

конечно-элементного расчета может быть получена очень подробная 

информация о работе конструкции; 

▪ МКЭ изначально был предназначен для использования его на компьютерной 

технике и в настоящее время написано много программ реализующих этот 

метод. Это позволяет органично включить данный метод в САПР предприятия; 

▪ В конечно-элементной постановке могут быть решены многие задачи, 

возникающие при проектировании конструкции. Кроме анализа упругих систем 



существуют алгоритмы на основе МКЭ для решения задач теплопередачи и 

аэродинамики. Это очень удобно с точки зрения автоматизации процесса 

проектирования, так как все работы могут проводиться на одном комплексе 

программ, и не возникает проблем с передачей данных из одной системы в 

другую. 

 

2 Примеры решения задач анализа, проектирования и 

оптимизация конструкций ракетно-космической 

техники в среде MSC.Patran/MSC.Nastran 

Примеры решения задач, представленные в данной главе, 

предназначены для ознакомления с приемами моделирования и расчетами 

разных типов ракетно-космических конструкций в среде программного 

продукта MSC.Patran/MSC.Nastran. Кроме того, эти задачи характерны для 

всех этапов конечно-элементного проектирования ракетно- космических 

конструкций. При решении этих задач могут быть полезны издания [5, 6 ,7]. 

Пример решения задачи №1 “Моделирование и статический расчет 

пластинчатой конструкции с использованием MSC.Patran/MSC.Nastran” 

позволяет на простом примере освоить общую последовательность работы 

при моделировании и статическом расчете, знакомит с универсальным 

конечным элементом оболочки Shell. 

Пример решения задачи №2 “Моделирование и статический расчет 

объемных силовых элементов конструкции с использованием 

MSC.Patran/MSC.Nastran” служит для приобретения навыков моделирования 

объемных тел в препроцессоре Patran с помощью конечных элементов типа 

Solid. 

Пример решения задачи №3 “Моделирование ферменных и рамных 

силовых элементов конструкции с использованием MSC.Patran/MSC.Nastran 

и расчет на устойчивость” знакомит с моделированием ферменных и рамных 

конструкций балочными конечными элементами Beam, элементами 

сосредоточенной массы Mass и выполнением расчетов потери устойчивости 

конструкции в линейной постановке (Buckling). 

Пример решения задачи №4 “Моделирование и расчет конструкции 

стрингерного отсека ракеты-носителя в среде MSC.Patran/MSC.Nastran” 

знакомит с моделированием конструкции типового стрингерного отсека 



ракеты-носителя. В этой работе выполняются расчеты напряженно-

деформированного состояния и потери устойчивости в линейной постановке. 

Пример решения задачи №5 “Проектирование конструкции 

углесотопластикового головного обтекателя ракеты-носителя в среде 

MSC.Patran/MSC.Nastran”. Целью данной работы является моделирование 

конструкции головного обтекателя ракеты-носителя с использованием 

слоистого конечного элемента типа Laminate, выполнение расчетов 

напряженно-деформированного состояния, потери устойчивости 

конструкции в линейной постановке, частот и форм собственных колебаний. 

Выполняется подбор числа слоев однонаправленного углепластика в несущих 

слоях обтекателя по условиям прочности. 

Пример решения задачи №6 “Моделирование наезда автомобиля на 

препятствие”. Цель работы рассчитать перемещение несущей конструкции 

автомобиля при наезде на неровность дороги. 

Пример решения задачи №7 “ Моделирование силовой работы 

фланцевого соединения двух стрингерных отсеков с учетом контакта между 

фланцами ”. Цель работы 

– познакомить студента с контактными задачами, а также изучить специфику 

работы фланцевого соединения, в частности конфигурацию зоны контакта 

между фланцами и особенности передачи сил через фланцевое соединение. 



 

 
 

2.1         

     
 

Главная цель при решении данной задачи - освоить общую 

последовательность действий при моделировании конструкции в 

MSC.Patran/MSC.Nastran. Поэтому в данной работе будет рассматриваться 

весьма простая конструкция – прямоугольная пластинка c отверстием. 

 

2.1.1 Описание конструкции 

Рассматриваемая конструкция представляет собой прямоугольную 

пластинку с отверстием из алюминиевого сплава размером a x b и толщиной 

t. С одной стороны пластинка заделана (рис. 2.1.1). К стороне, 

противоположной заделке, приложена сила Р, равномерно распределенная по 

стороне. Величины a, b, t и P для разных вариантов приведены в табл. 2.1.1. 

Требуется рассчитать поведение данной конструкции, предположив, 

что перемещения точек конструкции малы (отсутствие геометрической 

нелинейности) и материал работает в пределах линейного участка диаграммы 

напряжения-деформации (отсутствие физической нелинейности). 

При таких допущениях можно исследовать поведение конструкции с 

помощью решателя Линейная статика. Данный решатель является наиболее 

простым из всех алгоритмов, реализованных в методе конечных элементов, и 

представляет собой решение системы линейных уравнений метода 

перемещений : 

[К]{u} = {P}, (1) 

где [К] - матрица жесткости; {P} - вектор узловых сил; {u} - вектор 

перемещений. 

Составление и решение этой системы уравнений рассматривается в 

курсах “Строительная механика” и “Прочность”. 
 



 

Рис. 2.1.1 Рассматриваемая конструкция 
 

Таблица 2.1.1. Значение параметров конструкции для разных вариантов задания 
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1000 

2 100 50 4 800 

3 200 60 5 2000 
4 100 20 6 1000 
5 300 120 10 7000 
6 100 70 5 1500 
7 100 80 4 1000 

8 250 50 6 500 

9 100 40 4 700 

10 150 105 4 2000 

11 100 80 2 1000 
12 200 180 6 5000 
13 300 30 8 10000 

2.1.2 Конечный элемент тонкой изгибной оболочки 
типа Shell 

Для моделирования пластинки с отверстием используем конечный 

элемент Shell. 

Элемент Shell может воспринимать мембранную нагрузку, сдвиг в 

плоскости оболочки, поперечный сдвиг и изгиб. Этот элемент применяется 

для моделирования конструкций, состоящих из тонких пластин и оболочек. 

2.1.3 Создание базы данных задачи 

Для того чтобы начать работу в системе MSC.Patran нужно открыть 

базу данных, в которой будет храниться вся информация о Вашей задаче. 

Для этого нужно выполнить 

a 

t 

b/
2 

R b 
P 

a/
2 



команду главного меню File>New. В появившемся окне (рис. 2.1.2) требуется 

задать следующую информацию: 

•  В поле “имя файла” набрать имя файла, в котором будет располагаться база 

данных Вашей задачи. Файл имеет расширение .db; 

•  В поле “Папка”, если не установлено, набрать адрес файла (путь директории на 

диске), где будет помещен созданный файл; 

• Для исполнения команды – нажать клавишу ОК. 
 

Рис. 2.1.2. Окно создания базы данных задачи 
 

2.1.4 Геометрическое моделирование 

Геометрическая модель в современных конечно-элементных системах 

используется для автоматизации процесса создания модели. Это достигается 

благодаря тому, что в препроцессорах реализованы алгоритмы 

автоматического разбиения геометрических объектов (кривых, поверхностей, 

объемов) на конечные элементы. 

Геометрическая модель может быть импортирована в Patran из CAD-

систем или сделана средствами самого препроцессора. В данном пособии 

геометрические модели будем создавать средствами Patran. 

Поскольку наша конструкция представляет собой тонкую пластинку, ее 

можно моделировать оболочечными элементами Shell. На оболочечные 

элементы в программе Patran легче всего можно разбить поверхности. Таким 

образом, геометрическая модель нашей конструкции будет представлять 



собой прямоугольную поверхность с отверстием. 

Программа Patran предоставляет пользователю много возможностей 

для создания поверхностей. Воспользуемся одним из подходящих в данном 

конкретном случае способов. 

1. Создадим четыре угловые точки и центр отверстия пластинки, для чего нужно 

войти в окно приложения Geometry, нажав клавишу , (рис. 2.1.3) и 

вызвать 

окно команды Create>Point>XYZ. Нужная команда набирается в выпадающих 

меню опций Action, Object, Method. 

Рис. 2.1.3. Окно команды создания точек по координатам Create>Point>XYZ 

 

Эта команда реализует один из возможных способов задания точек - 

XYZ. В поле Point Coordinates List в квадратных скобках задаются 

координаты X, Y, Z точек, разделенные либо пробелами, либо запятыми. 

Номер создаваемой точки система предлагает в поле Point ID List. Создание 

каждой точки происходит после правильного ввода всех необходимых 

данных, если включена опция Auto Execute. В противном случае 

– после нажатия клавиши Apply. Создайте угловые точки пластины и точку центра 

отверстия. Можно вывести на экран их номера, нажав на клавишу Show labels панели 

инструментов. 

2. Геометрическую модель предлагается сделать в виде плоской поверхности, 

ограниченной кривыми. Для создания такой поверхности в системе Patran требуется 

создать кривые по внешним границам поверхности и по границам отверстия. После этого 



нужно объединить кривые по внешним границам и по границам отверстия в составные 

замкнутые контуры. Ссылаясь на эти контуры создать поверхность пластинки. Это можно 

сделать так: 



 

▪ Для создания линий внешнего контура в приложении вызвать окно команды 

Create>Curve>Points (рис. 2.1.4). В полях Starting point и Ending point указать 

начальную и конечную точку создаваемой линии. Выбор точек осуществляется 

либо с помощью мыши, либо ручным вводом с клавиатуры номера точки в поля 

Starting Point List и Ending Point List. Номер создаваемой кривой система сама 

предлагает в позиции Curve ID List. Выполнить команду, нажав клавишу Apply. 

Рис. 2.1.4. Окно создания линий внешнего контура пластины 

 

▪ Для создания кривой внутреннего контура в приложении   вызвать окно 

команды Create>Curve>2DCircle. В поле Coordinate Plane List указать плоскость, в 

которой будет построена окружность. В примере на рис. 2.1.5 плоскость 

определена 3-й осью (Z) 0-ой (базовой) системы координат. Это 

означает, что окружность будет лежать в плоскости, перпендикулярной 

этой оси. В поле Input Radius укажите радиус окружности, а в поле 

Center Point List – точку в центре окружности. Выполнить команду, 

нажав клавишу Apply. 

▪ Для создания внешнего контура в приложении     выполнить команду 

Create>Curve>Chain (рис. 2.1.6). В поле Curve List укажите кривые 

внешнего контура. Внутренний контур объединять не нужно, 

поскольку он и так состоит из одной кривой. Выполнить команду, 

нажав клавишу Apply. 



 

 

Рис. 2.1.5. Окно команды создания окружности Create>Curve>2DCircle 

 
 

Рис. 2.1.6. Окно команды   объединения   линий   в одну   составную 

кривую 

Create>Curve>Chain 
 

▪ Для создания поверхности в приложении     вызвать окно команды 

Create>Surface>Trimmed (рис. 2.1.7). В поле Outer Loop List укажите кривую внешнего 

контура, а в поле Inner Loop List – кривую внутреннего контура. 



 

 

Рис.2.1.7. Окно команды создания плоской поверхности, ограниченной 

кривыми, 

Create>Surface>Trimmed 
 

В результате на экране появится поверхность, ограниченная кривыми с 

отверстием внутри. 

Для того чтобы посмотреть номера поверхности, кривых и точек, 

нажмите мышкой на клавишу  (Label Control) панели инструментов в 

правом верхнем углу экрана. В появившемся меню (рис. 2.1.8) щелкните по 

соответствующей клавише. 
 

Рис. 2.1.8. Панель визуализации идентификаторов 

объектов Клавиши панели означают следующее: 

 - показать идентификаторы всех объектов (All Labels); 

 - показать идентификаторы всех геометрических объектов(All 

Geometry); 
 

 

Fem); 

- показать идентификаторы всех объектов конечно-элементной модели (All 

 
 

 - показать идентификаторы точек (Point); 



 

- показать идентификаторы кривых (Curve); 

- показать идентификаторы поверхностей (Surface); 
 

- показать идентификаторы солидов (Solid); 
 

- показать идентификаторы узлов (Node); 

- показать идентификаторы элементов (Element). 

 
2.1.5 Задание характеристик 

конструкционных материалов и 
свойств элементов 

Характеристики материалов задаются в окне приложения , (рис. 

2.1.9). 
 

Рис. 2.1.9. Окно команды создания материалов Create>Isotropic>Manual Input 

 

В этом окне для задания изотропного материала пластинки выберем команду 

Create>Isotropic>Manual Input. В поле Material Name нужно задать имя материала. 

Нажатием клавиши Input Properties вызвать окно задания характеристик материалов 

(рис. 2.1.10) 



 

 

Рис. 2.1.10. Окно задания характеристик материалов 
 

В этом окне можно задать упругие характеристики материала, 

коэффициенты теплового расширения и теплопроводности, а также 

плотность, демпфирование и многое другое. Для линейного статического 

расчета в опции Constitutive Model нужно выбрать линейно-упругий тип 

материала Linear Elastic. Далее задать модуль упругости (Elastic Modulus), 

коэффициент Пуассона (Poisson Ratio). В позиции Density можно задать 

плотность материала. В окне (рис. 2.1.10) после ввода данных не забудьте 

нажать ОК, а в окне создания материалов – Apply. 

Следующим шагом создания конечно-элементной модели является 

задание свойств конечных элементов (Property), где вводятся главным 

образом геометрические характеристики элементов и область применения 

свойства. Свойства каждого типа элементов содержат свой набор 

характеристик. Так, геометрия оболочечных элементов Shell характеризуется 

толщиной оболочки, а балочных элементов Beam - площадью поперечного 

сечения, моментами инерции поперечного сечения и т.д. 

Нажатием клавиши   вызовем окно приложения Property (рис. 

2.1.11) и 



вызовем команду Create>2D>Shell. В поле Property Set Name нужно задать имя 

создаваемого свойства. 

Рис.2.1.11. Окно создания свойств элементов 

При нажатии клавиши Input Properties появляется окно задания 

значений свойств элементов (рис. 2.1.12). Для элементов тонкой изгибной 

оболочки задаются материал (поле Material name) и толщина оболочки (поле 

Thickness). Остальные поля в этой работе задавать не нужно. Выполните 

команду – ОК. 



 

 

Рис. 2.1.12. Окно задания значений свойств конечного элемента Shell 
 

В поле Select members окна создания свойств элемента (рис. 2.1.11) 

нужно задать область применения этих свойств. Поместите курсор в это 

поле, и затем укажите курсором мышки на поверхность пластинки. 

Выполните команду – Apply. 

2.1.6 Создание конечно-элементной сетки 

Размер конечного элемента в этой задаче рекомендуется выбрать такой, 

чтобы каждая сторона поверхности была разбита не менее чем на 10 

элементов. Данная рекомендация основана на двух соображениях. Во-

первых, большее количество элементов не даст существенного увеличения 

точности в данной задаче. Во-вторых, брать меньшее количество элементов 

нецелесообразно, так как в такой маленькой задаче экономить не имеет 

смысла. 

Для создания конечных элементов на поверхности необходимо 

выполнить следующие действия. 

1. Указать размер элементов. Войти в приложение Elements, нажав клавишу . 

Вызвать окно команды Create>Mesh Seed>Uniform (рис. 2.1.13). Здесь можно 

задать либо число элементов вдоль кривой (опция Number of elements) либо размер 

элементов (опция Element length). Указав один из этих параметров, в поле Curve list 



следует указать (выбрать мышкой) к какой кривой (Curve) это 

относится. Выполнить команду - Apply. Таким образом назначить 

размеры элементов для всех кривых поверхности пластинки. 

Рис. 2.1.13. Окно задания количества элементов на одной из сторон 

поверхности пластинки 

2. Разбить на конечные элементы поверхность пластинки. Это можно сделать в

приложении Elements с помощью команды Create>Mesh>Surface (рис. 2.1.14)

следующим образом:

• Щелкнув мышкой в поле Select Surface ввести идентификатор поверхности пластинки

– или набрать номер поверхности или указав ее мышкой на экране;

• Установить опцию Elem Shape в положение Quad, так как разбивать пластинку будем

на четырехугольные элементы;

• Установить опцию Mesher в положение Paver. Этот алгоритм разбиения способен

создать сетку на поверхностях любой сложности. Алгоритм IsoMesh может разбивать

только топологически четырехугольные или треугольные области;

• Установить опцию Topology в положение Quad4, так как элементы будут

четырехузловыми. В полях Node и Element система показывает, с какого значения она

начнет нумеровать новые узлы и элементы при выполнении этой команды;

• Размер элемента внутри поверхности определяется параметром Global Edge Length.

Для этой задачи рекомендуется отключить автоматическое вычисление значения этого

параметра (опция Automatic Calculation) и задать это значение в поле Value примерно

равным размеру элементов вдоль границ;



• Перед выполнением команды (нажатие клавиши Apply) рекомендуется сохранять 

модель, потому что в случае неправильного указания размера конечного элемента, 

элементов на поверхности может оказаться слишком много и компьютер 

повиснет. Сохранение модели осуществляется командой File>Save 

главного меню. 

В результате выполнения команды на экране появится КЭ-модель. 

Примерный вид модели пластинки приведен на рис. 2.1.15. 

Для разных размеров элементов по границам и внутри поверхности 

получаются разные конечно-элементные сетки. Наиболее точные результаты 

будут получаться, если все оболочечные конечные элементы по форме будут 

близки к квадратной. Меняя размеры элементов вдоль границ и внутри 

поверхности, постарайтесь добиться, чтобы конечные элементы по 

возможности имели правильную форму (отношение длины к ширине 

элемента меньше 2, отклонение углов от прямого угла не более 30). 

Рис. 2.1.14. Окно создания сетки конечных элементов 



Рис. 2.1.15. Конечно-элементная модель пластинки с отверстием 

2.1.7 Задание граничных условий 

Граничные условия по физическому воздействию разделяются: 

▪ на силы и моменты в виде сосредоточенных и распределенных по длине и площади

нагрузок;

▪ заданные перемещения;

▪ кинематические воздействия – ускорения, скорости и перемещения;

▪ тепловые воздействия в виде температуры и теплового потока.

По способу приложения к объектам модели нагрузки классифицируются

как:

▪ объемные;

▪ узловые;

▪ элементные.

Расчет может проводиться для сложного сочетания граничных условий.

Граничные условия в системе MSC.Nastran можно разделить на

нагрузки и закрепления. Нагрузки преобразуются в компоненты вектора 

узловых сил (вектор Р в уравнении (1)), а закрепления являются 

дополнительным уравнением, исключающим закрепляемые степени свободы 

из расчета. Например, перемещение по какой либо степени свободы 

приравнивается нулю. К закреплениям относятся заданные перемещения, 

заданные поля температур в задаче теплопроводности и др. Нагрузки могут 

задаваться в любой удобной системе координат, а закрепления – только в 

системе координат узлов модели, оси которой совпадают со степенями 

свободы узлов в расчете. В связи с этим мы будем разделять граничные 

условия на закрепления и нагрузки, хотя в системе MSC.Patran они и 



задаются одним приложением. 

Граничные условия задаются   в   приложении Loads/BCs   (клавиша ). Создадим 

закрепления вдоль одной стороны пластинки с помощью команды 

Create>Displacement>Nodal (рис. 2.1.16): 

• в поле New Set Name задайте имя закрепления; 

• клавишей Input Data вызовите окно задания величины заданных перемещений 

(рис. 2.1.17). В поле Translations следует ввести вектор поступательных 

перемещений, состоящий из трех компонентов, разделенных пробелами или 

запятыми и объединенных в угловые скобки. В поле Rotations следует ввести 

вектор поворотов в том же формате. Заделке соответствует закрепление по всем 

степеням свободы и в этом случае оба вектора, определяющие заданные 

перемещения, примут вид “< 0, 0, 0 >”. Если нужно задать перемещения не по 

всем степеням свободы узлов, то значение перемещения по незакрепляемым 

степеням свободы нужно пропустить (например, < 0, , 0 >). Вернитесь в окно 

приложения Loads/BCs, нажав клавишу ОК; 

• клавишей Application Region вызовите окно задания области применения 

граничного условия (рис. 2.1.18). В нашем случае мы должны задать 

перемещения для узлов, лежащих на одной из граней поверхности пластинки. 

Это можно сделать либо выбрав опцию Geometry и указав в поле Select 

Geometry Entities грань поверхности, либо выбрав опцию FEM (английская 

аббревиатура от “конечно-элементная модель”) и указав в поле Select Nodes 

узлы, лежащие на грани поверхности. Выполнить команду, нажав клавишу 

Apply. 

 



Рис. 2.1.16. Окно команды Create>Displacement>Nodal приложения создания 

граничных условий Loads/BCs 

Рис. 2.1.17. Окно задания величины вынужденных перемещений 



 

 

Рис. 2.1.18. Окно задания области применения граничного условия 
 

Приложим к нашей конструкции действующую силу. Поскольку сила 

распределена по стороне пластинки, то ее необходимо распределить между 

узлами, лежащими на данной стороне. Для того чтобы сила распределилась 

равномерно, в каждый узел на стороне надо приложить долю силы, равную 

P/nэлем, где nэлем – число элементов вдоль стороны. В угловые же узлы должны 

быть приложены силы P/(2nэлем). 

Зададим силу вдоль стороны пластинки, противоположной 

закрепленной, с помощью команды Create>Force>Nodal, (рис. 2.1.19). Это 

делается подобно заданию заданных перемещений. Только вместо векторов 

перемещений задаются векторы сил. 
 



 

Рис. 2.1.19. Окно команды Create>Force>Nodal задания нагрузок в приложении 

Loads/BCs 
 

Совокупность граничных условий, описывающих условия 

функционирования конструкции в какой-либо ситуации, называются случаем 

нагружения. Все созданные граничные условия помещаются в случай 

нагружения с именем Default (по умолчанию). На практике часто приходится 

исследовать поведение конструкции для нескольких случаев нагружения, 

каждый из которых характеризуется своими нагрузками и своими 

закреплениями. Для того чтобы не создавать для каждого случая нагружения 

модель со своими закреплениями и нагрузками модель может содержать 

несколько случаев нагружения. Посмотреть состав этого случая нагружения 

или создать другие случаи нагружения можно с помощью приложения Load 

Cases (клавиша ). 

2.1.8 Запуск на расчет 

Запуск на расчет выполняется в окне приложения Analysis (рис. 2.1.20), 

которое 

открывается нажатием клавиши , командой Analyze>Entire 

Modal>Full Run. Вид анализа выбирается с помощью клавиши Solution type 



(рис. 2.1.21).. При решении этой задачи мы считаем, что в материале нет 

пластических деформаций, перемещения точек 

конструкции малы и существенно не  изменяют геометрию конструкции. Нагрузка 

неменяется во времени. Такой ситуации соответствует вид анализа Linear Static (линейная 

статика). Клавиша Subcases позволяет настроить расчетный случай (выбор случая 

нагружения, набора выдаваемых результатов и др.), а клавиша Select Subcases позволяет 

выбрать расчетный случай (случаи) для расчета. Для случая нагружения Default расчетный 

случай настраивается и выбирается по умолчанию. Остальные клавиши дают доступ к 

различным опциям, в которых здесь нет необходимости разбираться, поскольку их значения 

по умолчанию подходят в нашем случае. 

После нажатия клавиши Apply происходит следующее: 

•  Patran генерирует файл задания на расчет для системы конечно-элементного 

анализа MSC.Nastran; 

•  Система MSC.Nastran запускается и выполняет расчет в соответствии с заданием 

на расчет. В результате расчета создается файл (в нашем случае с расширением 

.xdb), содержащий результаты расчета. 

Для того чтобы посмотреть результаты в системе Patran нужно присоединить файл 

результатов к базе данных Patran-а. Это можно   сделать   с   помощью   команды 

Access Result Data>Attach XDB>Result Entities. Здесь нужно указать файл с 

результатами с помощью клавиши Select Result File и нажать клавишу Apply. 

 

Рис. 2.1.20. Окно команды Analyze>Entire Modal>Full Run приложения Analysis 



 
 

Рис. 2.1.21. Окно выбора вида анализа 
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